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Installation

* The Enzo installer automatically placed all Enzo plugmihé plugins folder of your
Photoshop installation. Typically, this is t@e/Program Files/Adobe/Photoshop */Plug-
Ins directory, and the Enzo plugins are installed in a nendated th€:/Program
Files/Adobe/Photoshop */Plug-Ins/EnzoPluginsglirectory. To make sure the installation
was successful, start Photoshop and go t&ilke> Open menu, then select theles of type
pulldown menu and look for new file types added, such as @0i&tMaya, Softimage, etc.

* Open Photoshop, go Window->Actions, click on the right arrow button, and in the popup
menu, chooskoad Actions. In the file browser that pops up, choose:
C:/Program Files/Electriclris/Enzol.0/enzo.atn  You should see the following:

Histor Actions Tool Presets
| |= 1 enzo _;
|7 |_ = Enzo - 30 Yiewer |-
|7 |_ Enzo - 30 Viewer
|7 |_ = Enzo -&pply Faint
|7 |_ Enzo - Apply Paint d
3 @ =R

You are done! YouF3 key is now mapped to Enzo3D viewer, andF2 is now mapped to
Enzo’sApplyPaint command.

NOTES:
» If for some reason the plugins were not installedemily, you can find a copy in the

C:/Program Files/Electriclris/lEnzo1.0/EnzoPluginsdirectory. You can manually place a
copy of this folder under the Photoshop plugins folder.
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LOADING 3D FILES

Once Enzo is properly installed, using Photosh&p&s>Open command, new file types
appear: 3D Studios Max (*.3DS), Enzo (*.NZO), LightWa¥&\O), Softimage (*.XSlI),
MayaFormat (*.MB), MotionBuilder (*.FBX), Rhino (*.3DM) ahWavefront (*.OBJ). With
the exception of Enzo’s own .NZO and Wavefront’s .@d8dnat, the other 3D formats can only
be loaded and not saved at this time. The figure belowskthe newFiles of Typepulldown
menu after the Enzo plugins have been installed.

I|.-'1‘-.II Formats j

Phatozhop [*.PS0;" FDD) -
— |30 Studio Max [7.305,%.305]

BMP [*BMP;".RLE".DIB]

CompuServe GIF [*GIF]

D30/DDs [*.0DS)

D30T extureFormat (7005 HDR ™ PR PP
dat=S1 [* =517 %51

Erzo [FHZ0;" MZ0])

Photoshop EPS [*.EFS]

Phatoshop DCS 1.0 [ EPS)

Photoshop DCS 2.0 EPS)

EFS TIFF Preview [".EPS]

Filmztrip [*.FLM]

JPEG [FJPG;"JPEG: .JPE]

Lightw'awve [* Lw'0". Lw0)

t ayaFarmat [*MB " MA]

MotionBuilder FB= [ FB=." FEX)

Generc POF [* PDF FOP; Al)

Generic EFS [FAI37 A4 A5 AIBT AT A8
PO [ PCH)

Phatoshop POF [* PDF:*.FDF)

Acrobat TouchUp Image [* FOF; A7 PDP]
Phiota CD [*.PCD)

FICT File [* PCTPICT)

Fimar [*.F=R]

FMG [*.PHG]

Rat [ Rahe

=» |Rbino 30M [~ 30M." 30M)

Scites CT [*.5CT]

Targa [ TGEA" VDA ICB" W5T)

TIFF [“.TIF . TIFF)

= |'wWavefront [* 0B 0BJ)

wihirelesz Bitmap [ WEMP WER)]

All Formats

b

Wb

<




MAYA NOTES:

Maya (any version between 4.5 and 8.5, inclusme¥t be installed on the same machine
running Photoshop/Enzo, in order for Maya files to be abletmaded. Enzo witiot be able
to load Maya files otherwise.

All the 3D files above load directly into Photoshopthithe exception of the Maya file types.
Maya files are automatically converted to Enzo forasaén intermediate step and the
corresponding Enzo file is loaded. This is done via the
C:/ProgramFiles/Electriclris/Enzo1.0/mb2nzo.exeutility. As an example, if you use
File=>Opento load the Maya filéest.mb, Enzo quickly converts it teest. mb.nzoand loads the
Enzo version of the file. This has been implemenibés way mainly because of how the Maya
API libraries function, but also to speed up future logdihthe same Maya file. Enzo loads .nzo
files faster than Maya files. Should the original mé&le (test.mb) change, Enzo detects that it
has a newer file date, and re-converts tegi.mb.nzobefore loading it. You doot have to run
themb2nzo program manually, it is done automatically for you.

You will notice there are many versions of thie2nzo*.exefile, such as mb2nzb.exe,
mb2nz&0.exe, mb2nz60.exe, mb2nza0.exe, mb2nz80.exe, and mb2n&5%.exe. These are
individual converters for the corresponding version of/lthat you have installed on your
machine. The Enzo Installer automatically runsseteipEnzo.batfilefor you, which tries to
detect the version of Maya installed on your machine apg that version to be the one used by
Enzo, named simplynb2nzo.exe.
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ENZO- 3D VIEWER

3D iewer F3 |
apply Paink Fz
Texture YWizard

Modes and Materials
Open Textures
Save Textures
Show Lvs

Render Window
Preferences

Help

Enter the 3D viewer by pressing th& key, or more by mapping any key to the
Enzo->3D Viewer menu item. It ihighly recommended to use a hotkey for entering 3D mode,
since you will be entering and exiting frequently.

There are different ways to orbit the camera in thevigiver:

Maya Style:
ORBIT: ALT + Left Mouse Button
TRACK: ALT + Middle Mouse Button

ZOOM: ALT + Left + Middle Mouse Button

LightWav e Style:

ORBIT: ALT + Left Mouse Button
TRACK: ALT + SHIFT + Left Mouse Button
ZOOM: ALT + CTRL + Left Mouse Button

Softimage|XSIStyle:

TRACK: S Key + Left Mouse Button
ZOOM: S Key + Middle Mouse Button
ORBIT: S Key + Left + Middle Mouse Button



Softimage|3DStyle:

ORBIT: O Key + Left Mouse Button
ZOOM: P Key + Left  Mouse Button
PAN: ZKey+ Left Mouse Button

For quick reference to these key bindings, you may refdrwetirizo>Help menu.

Note that the Right Mouse Button is not used in theecaroontrols. This is because Enzo uses
the Right Mouse Button click to quickgxit out of 3D-viewer mode.

Important: You will be entering and exiting the 3D viewer frequenttyjtss highly
recommended you create a shortcut key, F2 to help sa@eRmactice going into/out of 3D
Viewer mode a few time$:3, orbit, RightMouseClickF3, orbit, RightMouseClick.

Tip: Itis a but subtle to know whether you are in 2D (Phaip}or 3D (Enzo) mode. The
indicator for 3D mode is the Red, Green, and Blue axisdarbottom left corner, as well as the
white text in the center bottom.

iz trex5.4.mb @ 100% (RGB)




HOTKEY — KEYBOARD BINDINGS

Hotkeys (keyboard shortcuts) are an important part od EAlt display modes and camera
controls are done via keyboard hotkeys. Below is tiheptete list:

A —View the model with thélpha channel of its RGBA color map applied. This applies
only to models that use a RGBA texture format for tRmitor map.

B — View the model with it8ump map textures applied.

C —View the model with it€olor map textures applied.

E — View the model with it&€nvironment map textures applied.

F — Frame the selected model to be in the center of thec8bes Sets the camera’s interest
point to be at the center of the selected model.

G —Toggle the visibility of the 305rid.

H —Hide the selected object(s).

L — Toggle the_ights in the scene. Used to turn on / off the lightss is a verymportant
feature of Enzo, as it shows the combined effectdl dh@kextures: Color, Bump, Normal,
Environment, Specular, and even Displacement)

M — Toggle through the different render types, i.e., thrabgldifferent texture map types
(color, bump, normal, environment, specular).

N —View the model with itsNormal map textures applied.

O —Used to orbit the camera, along with the left mouse huttothe Softimage|3D style.
P —Used to pan the camera, along with the left mouse huttahe Softimage|3D style.

S —Used to Orbit/Track/Zoom the camera in Softimage|X3é sty

T — Used to open the 2D texture of the selected model(#)no model is selected, to open
the textures for all the models in the scene. Onlyekiires in the current mode (e.g. color,
bump, spec, etc) are opened. To open all the Bump noapesxedmple, preds3 to enter the
3D viewer, therB to enter Bump map mode, th&rto open all Bump map textures.

W — View the model inVireframe mode.

X —View the model with it$Specular map textures applied.

4 —View the model inVireframe mode. Same as tekey.

5 —View the model in shaded mode, without any texture mapkeal.

6 - View the model with it€olor map textures applied. Same as@hieey.

1 - UP Arrow — Set the light position to be above the model.

| - DOWN Arrow — Set the light position to be below the model.

~ - LEFT Arrow — Set the light position to be to the left of the mode

- - RIGHT Arrow — Set the light position to be to the right of the miode

ESC- Exit 3D-Viewer mode, same as the Right Mouse Button.



Below are a few examples of the use of hotkeys.
Press th& key to see theolor map. You can press the key to go back to wireframe.

i trexs.4.mb @ 100% (RGE)

Press thd key to see thbump map. You can press th# key to go back to wireframe.

i trexs.4.mb @ 100% (RGE)

hump




LIGHTING

While in 3D Viewer mode, the model can be viewed witlwvibnout lighting effects. Pre$s3 to
enter the 3D Viewer, then prelsdo turn on lighting, then use the four arrow keys
(up/down/left/right) to change the direction of the lights.

There are many properties to control how the modelndered, controlling its brightness,
ambient, specularity, bump amount, displacement mapsgasency, and reflectivity. These are
explained in more detail in ChapterE)zo Nodes andMaterials.

NOTE: Painting on the model always occurs with lighting @Bdurned off. This is so that the
shadows and shading do not affect the choice of color@adldending. For example, a soft
brush with semi-transparent edges that is painting ovarea of the same color should blend
evenly to produce the same color as before. If paintisfpadowed areas were allowed, then
that would cause the blended brush areas to come out too dark.

The other advantage of not allowing painting on a shambebk! is to produce better results
with Photoshop’s Clone Stamp Tool.



OBJECT SELECTION:

The Enzo viewer lets you select and hide 3D objects isdéee. Simply enter 3D mode3j,
use the left mouse button to click-drag select an obiéet.object will change color on release.

i trexS.4.mb @ 100% (RGB)

iz trex5.4.mb @ 100% (RGB)




You can hide the object(s) selected by pressingfitkey to hide the object. The object that was
hidden is still considered selected, so you cartlkey again to make it reappear.

iz trex5.4.mb @ 100% (RGB)

VIEWER RESIZING

When a 3D scene file is first loaded, the size of3beviewer window created is 512 x 512.
You may wish to make the window larger. There are tagswo accomplish this:

» Using the usual Photoshop way, with thege—>1mage Size...menu.

* Use the mouse to resize the document window by click amgjitigathe 3D window's
border. At first only the window will be resized, ame 3D Viewer itself will stay the same
size. But then press tiie key to enter the 3D Viewer, and the viewer size will
automatically be adjusted to fit the window. Rightide Button to exit the 3D Viewer. See
the figure below:



PRESE3 >
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ENZO->APPLY PAINT

30 Wiewer Fa |

&pply Paint Fz2
Texture Wizard

Modes and Materials
Open Texkures
Save Textures
Show Lvs

Render Window
Preferences

Help

One of the most powerful tools in Enzo is #aply Paint tool, which performs the actual
mapping of the painted brushstrokes. Abgly tool takes the paint changes made using
Photoshop, and applies them to the 3D model. Emgapdy function allows:

» Paintingdirectly on the 3D model, which then updates the 2D textures.

» Painting on the 2D texture and update the 3D model to tiewesults.

» Painting on Layers —Whether it’s &D layer or a3D layer, Enzo works very
closely with Photoshop’s own layering system to alisslating different features
into different layer.

» TheApply function works for any type of texture map — color, busgecular,
environment, etc.

Using theApply function is very simple. First, use any Photoshoptborgool to modify the
2D or 3D image. Second, press Hiekey, which will invoke theApply command.
To better illustrate, let's do some examples:



PAINTING ON 3D MODEL

Step 1:Load your 3D model an orient it using the Enzo 3D view&rKey), and exit the viewer
with a Right mouse button click.

|25 trex5.4.mb @ 100% (RGBE)




Step 2: Paint on top of the 3D model using any of the Photoshdg. idere we just use the
Brush Tool with a hard edge

|25 trex5.4.mb @ 100% (RGBE)

——1




Step 3: Press thé=2 key to run th&enzo>Apply Paint command. See the paint changes
applied to the 3d model.

|25 trex5.4.mb @ 100% (RGBE)




Step 4: The final result of the paint change can be viewed, ligititing, by entering the 3D
viewer againt3 key, orEnzo>3D viewer), and while in 3D mode, pressing thekey to see
the light effect. Pressing the L key again can togdi¢hef lighting effects.

|25 trex5.4.mb @ 100% (RGBE)




Step 5:1f you have the 2D texture of the model open, you w#l s@utomatically update:

23 skin3.tga @ 66.7% (RGB)

And the texture map for the teeth and nails:

4 nails.tga @ 100% (RGB) 8




PAINTING ON 2D TEXTURE:

Step 1: Select the 2D texture as the current document in PhoposPaint on the texture using
any of the Photoshop tools. Here we’ve added the greeredod$pots and line to the texture.

i skin3.bga @ 66.7% (RGB) =101




Step 2:Activate theEnzo>Apply Paint command by pressing ti@ key. The Photoshop
document with the 3D model will automatically update. fgpee below.

|25 trex5.4.mb @ 100% (RGE)




Step 4: The final result of the paint change can be viewed, ligititing, by entering the 3D
viewer againt3 key, orEnzo>3D viewer), and while in 3D mode, pressing thekey to see
the light effect. Pressing the L key again can togdi¢hef lighting effects.

final lighting




To summarize:

* Thecurrent Photoshop document is assumed to be where the newetstienges
have been made. So make sure to predszifrmm the window you just painted in.

» If the current document window is the 3D Viewer, theapahanges are applied and
any other windows that are open are automatically updatextlect the changes.

This includes all windows that are the 2D textures ofdadrifie geometry nodes in the
scene.

» If the current document window is a 2D Texture windowentthe changes made are
updated in the 3D Viewer window.

* Photoshop windows that are neither a 2D texture ndBEheiewer window are left
unchanged.

* On 2D Texture documents, layers are fully supported. Hgers may be created,
painted on, made visible or turned off. Layer foldersadse supported.

* Photosho EXT layers may also be used in a layer in a 2D Texture dextum

See Chapter 13PAINTING ON LAYERS for more details on painting on layers in general.
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ENZO->TEXTURE WIZARD

3D Wiewer F3
Apply Paink Fz

Texture Wizard

Modes and Materials
Open Texkures
Save Textures
Show Lvs

Render Window
Preferences

Help

Texture Wizard: Select the&enzo> Texture Wizard menu to display the Texture Wizard (see
figure below).



CREATING NEW TEXTURES

Each row in the list represents a geometry node, (poaigonesh or NURBS surface), and each
column represents the texture map type for that geome&iingckboxes that are checked
represent existing textures. Blank checkboxes signétyrib texture exists. Subdivision model
surfaces are not supported at this time.

x
Mode | W coler | T bump | T nomal | T environment | T specular |
Body v r r r I
M ails ¥ r r r r
Teeth ¥ r r r r

LEFT click on a node name to gzelect it in the 30 viewer,
RIGHT click on a node name to shaw itz texbure information.

k. E dit Cancel




To create and assign a new texture to a geomeds, wbeck on the appropriate entr(ies) and
click on theOK button. If we wanted to create bump maps for themdfft parts of our model,
we would click the checkboxes in thamp column. See figure below.

x
Mode | ¥ calar | W bump | T nomal | T environment | T specular |
Body v v r r r
Mails 4 [v r r r
Teeth v v r r r

LEFT click on a node name to zelect it in the 30 viewer.
RIGHT click an a naode name ta shaw itz texture infarmatian.

k. Edit Cancel




After clicking theOK button theCreate Textureswindow will appear. You may :

» Create New Texture(s) -Choose thé&ew item in theTexture pulldown field. Then
select one or more textures to be created in thedlstv, and choose the Width and
Height and initial color of the texture map to be aedat Choos©K when ready.

* Use an Existing Texture -Choose thé&rom File item in theTexture pulldown
field. . Then select one or more textures to be craatdée list below, and click the
Choose... button to choose the image file to be used.

Create Textures X|

— Texture Properties

widh [512 =] Heignt 512 x| Testure [ 4

New

Directary Ehu:u:use...l |- Aresixsly
Color  Chosse.| [

— Create Textures

Body [bump] [512=512)
Mailz [bump] [512 % 512]
Teeth [bump) [B12 %512

] 4 Apply Cancel




DELETING TEXTURES

The Texture Wizard may be used to unassign and remove tektone geometry node(s) as
well. Simply Uncheck the appopriate checkbox in the Texture Wizard and €igk In the
figure below we set the Body model's texture for removal

Texture Wizard |

MHode | T color | T bump | T nomal | T ervirenment | [ specular |
Body - i n - r
M ails v r r r N
Teeth W~ r r r r

LEFT click on a node name to zelect it in the 30 viewer,
RIGHT click on a node name to show ks kexture infarmation.

k. E dit Caricel




A message box appears to confirm the texture removalseque

Delete Textures x|

0k ta delete the fallowing textures?

Bady [calor)

k. I Cancel




TEXTURE INFORMATION

Right Clicking on the name of a geometry node in teetdre Wizard will display the Node
Texture Information window for that node. See below.

Mode Texture Information x|

Body
color map: [C:Areslw0 skin3 tga] [1024 = 512]
burmp map: [C:Ares<5 1B ody_bump.tga] (512 # 512
normal map: [C:Arex<51/Body_normal tga) (512 % 512]

DOUBLE click a texture to opet itz file.

i |

Cancel
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ENZO->NODES and MATERIALS
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TheMaterial Editor provides two features:

» Creation andassignmentof new matrials to geometry nodesMaterial is used to
specify the rendering features of a model's geometry.
1. Specular size
2. Specular brightness
3. Diffuse brightness
4. Ambient brightness
5. Bump amount
6. Bump Parallax mode
7. Displacement amount
8. Displacement enable/disable
9. Reflectivity amount
10. Refraction amount

» Editing of the properties of a material.



MATERIAL CREATION & ASSIGNMENT

Using theMaterial Editor should be simple. There is odefault material (that can not be
deleted), and th€reate button allows creating new materials. Materials lsamenamed using
the Edit button and changing thdaterial Name field.

Assigning a Material to a geometry node is done byléytseg one or more nodes from the
Nodeslist on the left side of the panel, 2) selecting tharddsnaterial from th&laterials list
on the right hand side, and 3) pressingAksignbutton.

Materials may be deleted by selecting the desiredriaband pressing tHeelete button.

I Material Editor X|

Modes b aterials
----- fﬂ persp < matenal: default > deftaullt 1
rnateria
----- IEE top < mnaterial: default material2
----- P2 front < material: default > material3
----- @R side < material: default >
= 4 Trex < matenial default > Materials

----- - Body < material default >
""" . Mailz < material materials >

------- ' Teeth < matenal: matenal3 »

Delete |

Modez
Hide/Shaw

Showw All

1l

Wire/T exture

¥ Show Assigned

OF.




EDITING MATERIAL PROPERTIES

TheMaterial Properties Editor can be started by either double clicking on the mateaialenin
the Material Editor or selecting the material name and pressindgethie button The properties
will be shown (see figure below).

default =
b aterial Mame: Idefault
— Specular
Size | i [128
Brightness | | IEI.EEI
— Diffuze
Brightnesz | | |1 .00
— Ambient
Brightnesz | — | IEI.EEI
— Bump
.-’-\-.mc'unt| i ITUU
[~ Parallax
— Dizplacement
.-i‘-.mu:uunt| i g.10
[~ Enable
— R eflectivity
Armount | | IEI.EIEI
— Refraction
Amaount | | IEI.EIEI
] Cancel |

Most of the properties are self-explanatory. A feweso

» TheParallax checkbox is an alternative way to show bump mapsifact éor added depth
as the camera moves around the object.

» Displacement— TheBump map can be simulated as if it were a displacemept @aggling
the Enable checkbox to ben will activate this feature. ThBisplacement Amountis the
distance, in world space, of how much to displace theseidf the model.



» Reflectivity — This feature can be used to simulate chrome or wétioy,geflective
surfaces. You must assign Bnvironment Map texture to the model(s) in order to see
any results. The default (no texture) is a gray casd for reflection.

» Refraction — This feature can be used to simulate glass or translogetials. You
must assign a background image Enzo, uBimgo—> Preferences>3Dviewer (see
below).

x

A0 Wiewer | Camera I

B ackground
30 gnid

 Solid Color I:h::-::use...l I
" Image Choose.. | [CutresS1\bo3.jpg

[ BG layer zeparate

|1 wiger

= Path view
i | aper view

k. I Cancel F¥u]m 1




After selecting a background image, the 3D viewer in Photsvill look like the figure below:

i@ trex5.4.mb @ 100% (RGB)

Below are a few images of our model after differentamal settings for bump, reflectivity, and
refraction:



With bump map enabled:

i trexS5.4.mb @ 100% (RGE)

final lighting




With bump andreflection map enabled:

"l trex5.4.mb @ 100% (RGB}

L ————

final lighting




With no bump, 100% reflectivity, against background image.

i trexS5.4.mb @ 100% (RGE)

final lighting




With Refraction at 99%, with background enabled:

S trex5.4.mb @ 100% (RGB)

final lighting
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ENZO->OPEN TEXTURES
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Selecting th®©pen Textures menu will operall the textures which belong to the 3D scene,
if no 3D models are selected. If a 3d object is seldiobed the scene, then
Eno->OpenTexutre, or, alternatively th& key while in the 3D viewer will open the selected
textures.

Enzo internally is aware of several image feets (.JPEG, .TGA, .TIF, .BMP), and uses
Photoshop for loading and saving all other formats. iBhaspowerful feature, leveraging any
8-bit RGB format Photoshop supports, any custom image file tyge Rexar), or any future
Photoshop Format Plugin releases.
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ENZO->SAVE TEXTURES

30 Viewer F3
Apply Paink Fz
Texture Wizard
Modes and Materials
Open Texkures

Save Textures
Show s
Render Window

Preferences
Help

All textures may be saved with a single comm&m,0-> SaveTextures Or, if the 3D
window is the current window, and the 3D file is an E(pao) format file, Photoshop’s own
File->Savecommand will save all the textures, after a confiroraprompt.

Alternatively, any individual texture may be saved méwpuasing Photoshop’sile-> Save
command.

Changing Texture File Type:lt is possible to change the file type of a textured@$tnzo.

One such situation would be if the texture is a singlerlile format such as Targa or Jpeg, and
you wish to change to a multilayer texture format suciPaotoshop .PSD.Simply use
Photoshop’s owikrile=> SaveAscommand to save a texture into Photoshop .PSD, or &ay ot
format.
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ENZO->SHOW UVS

30 Viewer F3
Apply Paink Fz
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Modes and Materials
Open Texkures
Save Textures

Show s

Render Window
Preferences
Help

IMPORTANT: Polygonal models must have UV coordinates alreadgesito them. NURBS
surfaces need not worry, as they have their UVs imlgliassigned. Enzo does not provide any
UV creation or editing tools at this time. Maya, So#ge, LightWave, 3DSmax are all very
powerful tools that already provide robust UV creatiot editing features.

Enzo> ShowUVsopens all 2D texture and displays their UV assignmenasRistoshop layer
(see figure below).

Alternatively, if a 2D texture is open and is the curiehotoshop documerEnzo-> ShowUVs
will show the UV assignments of only the selectedubext

Note: The UV layer willnot be ignored by Enzo during tigplyPaint step, so make sure it is
invisible or deleted when its not needed.



= E

Layers _Channels .:. iy
INorrnaI 'i Opacity:

Leck: [ &+ @ Fill: Jioozs [v ]

DEmm B
|§||_ ElLayerU

9.0 o ® & #|y
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ENZO-> RENDER WINDOW
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The 3D scene is usually in non-shaded, no-lighting modexder for the Photoshop paint to
blend correctly with the existing texture colors. Noilgab see the 3D model in shaded/lit
mode, one would have to press H&key to enter 3D Viewer mode, and if lights are not diyea
on by default, to turn them on using thdotkey.

TheEnzo>RenderWindow command opens a new window in Photoshop that is a preview
window that always shows the 3D scene in shaded moddigliting. It automatically updates
whenever the 3D model is changed in the normal 3D Vievirdaow.

The RenderWindow doest allow painting and applying paint directly in the
RenderWindow. It is simply a rendered view of the 3D scédime 3D viewer window is still the
main interface to Enzo.



5 trex5.4.mb @ 100% (RGB)

I R R R R e BRSNS mE——

final lighting
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ENZO->PREFERENCES
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General Notes:The preference settings are stored @x/@nzo.nzrcfile. If for any reason this
file is deleted, internal Enzo default settings arelsel the file is created again. If the Enzo
camera behaves in an unusual way, deleting this fdeniay to force a reset of the default
values.



ENZO->PREFERENCES>3D VIEWER

x

A0 Yiewer | Camera I

Background
f+ 30 gnd

£~ Solid Colaor Ehu:u:use...l _
" Image I:h::-::use...l IE:Hfrench}I.ipg

[T BG layer separate

|1 weiger

i Path view
% Laper view

k. Cancel Spply

BACKGROUND

The background in the 3D viewer is customizable to be oti@®éd options:

* 3D Grid — A standard 3D grid common to most 3D graphics packages.

» Solid Color - Alternatively, a solid color may be chosen as thé&aund. Use this
selection along with the tophoose...button to choose the desired color.

* Image - Sometimes it is useful to see the 3D model being paintedritext, with a
background image, to help with color selection and "bleniiihthe look. To load a
background image into the Model Window, choosdtiege button, therChoose...button
to find the background image you like to use.

BG LAYER SEPARATE

TheBG Layer Separateoption separates and places the 3D model into a ditffetestoshop
layer than the background. The 3D model will be placedlayer calledcene and the
background will remain in the background layer. The re&soaoing this would be for
“painting” transparency maps. The separate layers dtlowrasing parts of the 3D model to
see through to the background.



UV VIEWER

This option allows for specifying how the UV wirefransedisplayed on the 2D texture. It may
be displayed as a separate Photoshop Layer, orlas@sRop Path. Paths have the advantage
of remaining crisp as the image is scaled larger asaselbt affecting the mapping if
accidentally left on. Layers have the advantage migosore convenient in terms of enabling
and disabling visibility.

ENZO->PREFERENCES>CAMERA

x|

30 Viewsr  Camera |

Clipping Planes

Mear Plane: I Far Flane: I‘I noaoa

Rezstore Defaults |

ak. I Cancel Spply

Camera: This menu allows for setting tindear andFar planes of the camera. If the 3D object
is not visible, it is very possible it is too near @o tlose to the camera. Setting these numbers
appropriately will solve the problem. Note that sefecthe 3D model in the viewer (if visible)
and pressing the key to frame the object, automatically adjusts the/fegasziewing planes.
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ENZO->HELP

30 Viewer F3
Apply Paink Fz
Texture Wizard
Modes and Materials
Open Texkures
Save Textures
Show Lvs

Render Window
Preferences

T

For quick reference, the rules and guidelines to using Efectigkly are also repeated in the
Enzo>Help menu. Below are screenshots of the screens.




Enzo Tips and Tricks

Hotkeys I 30 Wiewer I Te:-:turesl Eameral

— Photozhop Hotkeys

F3 - Enters 30 wigwwer for mowving the model around. Same as Enzo > 30 viewer.

F2 - Applies painted brush strokes to the model. Same as Enzo > ApplyPaint

It iz highly recommended to use hotkeys with Enzo. To st up your hotkeys:

1] Open the Actions Window in Photozhop Pafindows - Actions].

21 Click ar the right araw buttan . and Select the V'Load Actions' menu.

3] Ga to the C:hProgram FileshddobehPhotozhop C54FresetzhPhotozhop Actions
directary.

4] Chooze the EMZ0 ATH file.

8] Donel F3 should now ztart the 30 viewer, and F2 will &pply Paint b0 pour models.

2k, I Cancel Apply




Enzo Tips and Tricks

Hu:utke_l,lsl a0 Wiewsr  Textures I Eameral

— Texure Maps

11 For polygonal models, the L'z muzt be already be azzigned. Enzo does not
provide |I% creation or editing toolz at thiz time.

2] Testurez 512 & 512 and higher give better 3d paint mapping resultz.

3] For best image quality, texture sizes should be a power of bwa, [e.0., B4, 128,
A12, 1024, etc]. Othenwize, there may be a hahtly blurring of the kexture

4] bdary texture formats are supported. Enzo openz zome file formats ikzelf [jpea,
targa, bff, brop), and usez Photoshop to opendzave all other file formats.

8] You can paint directly on a texture and zee the rezults in the 30 scene view.
Juzt open the texture [Enzo-:0penT extures], paint, and hit the F2 key [or
E nzo-xApply Paint]

6] Photozhop lavered files can be uzed as texstures. Just zave the regular format
tewture as PSD, then prezss the F2 key [Enzo-»ApplyPaint], and follaw prompts.

71 Some 30 file formatz may not allaw for Photozhop testurez. Enzo's 30 file format
does. You can zave your 30 scene in Enzo format. Make sure the scene document
iz the cument window, and just use File->Save Az and chooze Enzo Format

k. I Cancel Spply




Enzo Tips and Tricks

Hu:utke_l,lsl A0 Yiewer I Testures  Camera |

— Camera Controlz

Enzo's camera controle are designed to be familiar to you, if you are a uzer of
Maya, Light'tave, or Softimage.  [The Right Mouse Button iz used by Enzo for
exiting out of the 30 wviewer. Sowe uze Left+iiddle instead].

by ztyle:

OREBIT - ALT + Left Mouze buttan
TRACEK - ALT + Middle tMousze Buttan

000 - ALT + Left + Middle Mouse Button

LIGHT'WAME stule:
ORBIT -ALT + Left Mouze Buttan

TRACEK - ALT + SHIFT + Left Mouse Button
Z00M -ALT + CTRL + Left Mousze Button

SOFTIMAGE | 3D style:

ORBIT -0 Key + Left Mouze Buttan
PaM - P Eey + Left Mousze Button

Z00M - 2 Fey + Left Mouze Button

SOFTIMAGE | =51 style:

ORBIT - 5 + Left Mousze Buthan
TRACEK. - 5 + Middle Mouze Button
00 -5 + Left + Middle Mouze Button

k. I Cancel Spply
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PAINTING ON LAYERS

PAINTING ON 2D LAYERS

As mentioned earlier, Enzo fully supports multilayerextures, as well as Texture layers,
texture folders, etc. Simply select and work on anyéfure layer, then pres2 to apply the
changes to the scene. You may hide as many layemiagigh, isolating a few layers, paint,
apply, and when ready make them visible again, and apglyetohe final result.

Even though a texture’s initial file format may sugmotly a single layer or background, such
as Targa, Jpeg, Bmp, etc. it is ok to create and worklaydrs. When it comes time to save the
texture Enzo will automatically save a version offtaened image and leave the layers in the
Layer window untouched.

If you wish to save the layers to your texture fiteen the texture’s file format must support
it. Enzo allows you to change your mind and convert fromsamgle layer format (TGA,
JPG...) to a multilayer format such as Photoshop PSDIBF. Simply select the 2D texture,
then save it out as the same name file, but witff@rent file extension. Then press th2 key
as if you were applying paint changes. Enzo will prompt gozohfirm the texture name/type
change.Note: Now the 3D scene has changed, since a geometry temyr@ssignment has
changed. You may wish to save the scene out as an BAD format, or make the change in
your original 3D format (Maya, XSI...etc), otherwise namie the scene is loaded it will still be
using your old single layer texture.
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PAINTING ON 3D LAYERS

There may be special circumstances where you wishiib grathe 3D model and have the
changes isolated to a separate layer in the 2D tewxindow.

It is possible to paint on a “scratch” layer ia 8D Model Window, and “assign” the
destination 2D texture target layer(s) for the painting.aleady know that painting on the 3D
model in the 3D Viewer window will automatically update toeresponding 2D texture
documents. But which layer? By default, Enzo updates siokdound layer. Howevewe
allow for any layer in a texture to get the new changelhe “switch” for turningon this feature
is creating a scratch layer in the 3D Viewer window araking sure it is the currently selected
layer. Note: Make sure to turoff this feature by deleting the scratch 3D layer whenrbis
longer needed.

Here are the steps to accomplish this. The figures balsovdemonstrate the process:

* In a 2D Texture window, create a new layer, and make isig the current selected layer.

* Inthe 3D Model Window, create a new layer. Go aheadhaimd a few brushstrokes on it.
Press thé&2 key to apply the paint changes and see the results stitateh layer you
created in the 2D Texture window.



Create a Photoshop layer as destination for the 3D paint changes.

i skin3.tga @ 50% (Layer 1, RGB)

[Horml =] Opacity:

e () 7 @ fosD]

s T

P e a

Create a Photoshop layer as 8wirce (scratch layer)of the 3D paint changes. Paint a few
stripes....

i trexS.nzo @ 100% (Layer 1, RGE)




Pres$2 in the 3D window to apply the paint. Its should look:like

2 trex5.nzo @ 100% (Layer 1, RGB)

Layers Channels Faths

[Mormal | Opacity:
Lock: [ &+ @ Fill: oo |+ |

However, you'll notice that 3D paint applies now liesaoseparatéscratch) layer in the 3D
viewer document, and you may hide the background to seewhieranshstroke applied.

i trex5.nzo @ 100% (Layer 1, RGB) [




IMPORTANT NOTE:

The scratch layer on the 3D document is just thatcradch layer, and has not been
“registered”with Enzo as part of the texture, even thatighpears as a layer in the 2D texture

document. To register the paint change, delete theekdegter from the 3D document, then go
to the 2D texture document, and pre&s



PAINTING TRANSPARENCY MAPS

i trex5.4.mb @ 100% (scene, RGB)

|Mormal = Cpacity: oo [+ |
Lock: [ &+ & Fill: J100ss [+ |

=

@ .0 a ® & 3z

Enzo allows for painting an object's Alpha Chanhieis can be done in several ways.
ERASE 3D MODEL

The first method is using Photoshop's Eraser Tool in th#188el Window directly. You may
have noticed that the 3D Viewer window contains onlyckgeound layer, so we need to
separate the model from its background in order to be @lglease parts of the model. Select the
Enzo>Preferencesmenu, then select thdewer tab, and then toggle on tB& separate
checkbox. Click the OK button. Notice that in the 3[2Wer window a new layer calletene

has been created, and the model is now out of the Baakdjdayer and in thecenelayer.

The camera can still be placed around the 3D dwnepeessing th€3 key (Enze>3D
Viewer) and orbiting around. RightMouseClick to exit 3D mddetice that both the
Background and the scene layer are updated. You are ndwtoestart painting the
transparency channel of the model.

Make sure thecenelayer is the currently selected layer, then use tasdf Tool from the
Photoshop toolbar to start erasing parts of the modkkisdene. You may wish to change the
Eraser Tool's opacity by dragging the Opacity slider irPthetoshop Options toolbar. After you
have completed erasing, you still need to pres&2hey (Enze> ApplyPaint) to apply your
Eraser changes to the model's textures. See figures:belo



'; trex5.nzo @ 100% (scene, RGB)

i@ skin3.tga @ 50% (Layer 0, Alpha 1)

= a1Tm ,:
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PAINT 3D ALPHA CHANNEL

Another way of painting the transparency channgi®@imodel is by painting a black and
white (and shades in between) version of the model. Vihites are opaque, black areas are
transparent. Enter Transparency Render mode by pressiRg kieg to enter the 3D Viewer and
then press thA key to get a black and whigdpha Channel render of the 3D scene. Click the
RightMouse Button to exit 3D mode. Now you can start pajrthe black and white version of
the transparency. Do not forget to pressfBdey when you're done with painting so that the
paint changes are applied. You may paint either dirécthe 3D Viewer window or the 2D
Texture window.

% trex5.nzo @ 100% {scene, RGE)




PAINT 2D TEXTURE ALPHA LAYER

The final way of painting the transparency chanh#i® model is to paint the Alpha channel
of the 2D texture. Select a 2D Texture window of thxtue you wish to paint. Make sure that
there is no Background layer, which has no transparevaynel, but rather just a "regular”
layer, with a transparency channel. (SeeBhekground vs Layerssection below if this is not
clear). To change a Background layer into a regular Iay®ply rename it from "Background"
to something else. You may now use the Eraser tool te peats of the texture as you desire.
Don't forget to press tHe2 key (Enze> ApplyPaint) to see the 3D Model Window update with
the new transparency effects.

i skin3.tga @ 66.7% (Layer 0, Alpha 1)

= Alpha 1

G O & @4

Pressing th&2 key in the 2D texture window updates the 3D window:

i trex5.nzo @ 100% (scene, RGE) -5:" _"| g[ﬁ
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RANDOM NOTES

ALPHA vs. TRANSPARENCY

There is a difference between Transparency and Alpenhels”. In the film industry, the terms
Transparency Channel and Alpha Channel are synonymous. tiosRbp, they are not: There is
a difference between Photoshop Alpha channels and tta Alpannel in a RGBA file format’s
Alpha Channel

Alpha Channels: In Photoshop, in the Channels Window, there are tl&, Rnd B Channels.
You may add a channel by clicking the "Create New Charmeton. Photoshop calls these
Alpha Channels by default. Many Alpha channels may bet@de This in itself may create some
confusion, because one frequently thinks of an image asdhaue Alpha Channel at most:
RGBA. Most file formats support only RGBA.

In Photoshop these Alpha channels are not a repaigsarof the Transparency of the image,
but rather as a MATTE channel, or as a "scratch" cHaarkee used for any purpose(s). The
Alpha Channel is NOT the Transparency Channel.

Transparency: Photoshop does not give the user direct access tadahsparency channel
through its Channel Window. A layer’s transparency chiacane be modified using the Eraser
Tool, or modify with the Brush/Pen/Pencil Tool whenvrgixels are created over transparent
ones. In some file formats such as .PNG, Photoshogsparency becomes an Alpha Channel
(in file format terminology), when that image is sdas a file that is 32 bits per pixel, RGBA. In
some file formats such as TARGA, the Transparen@nisred and only the Alpha Channel that
is in the Channel window is used for the file format’'sB#GAlpha Channel. Its in fact
sometimes confusing and seemingly inconsistent.

BACKGROUND vs. LAYERS



When aNew Document is created Photoshop allows a choice ledéreliackground color, or
Transparent. You will notice in the Layer Window, tligtou chose a color, the layer created is
called "Background”, and has a lock on it. This is a Backgtduayer, and does NOT have a
Transparency Channel, and the Eraser tool does not WaeekEraser tool only works on layers
that DO have a Transparency Channel.

Any new layer that is created ("Create New Labetton)doeshave a Transparency
channel, andan be erased. So, a Photoshop Layer can be thought &2akiaRGBA layer and
a Background "Layer" can be thought of as a 24 bit RGB.l#yeimage can only have one
Background layer, but many RGBA layers.

It is possible to convert a RGBA layer into a Ri@ger, and convert a RGB layer into a
RGBA layer as well

 RGB to RGBA: Simply select the Background layer, double click on timeeyand rename
it. It is now a RGBA layer with a hidden Transparencyaiel

» RGBA to RGB: The only way to convert a RGBA layer into a RGB lafackground) is
by the "Flatten Image" menu. So most probably you would walyt a single layer in the
document before running "Flatten Image", otherwise the dalgers will be included as well.



